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1 General Info

1.1 Introducing CurrencyManage 2016

What Is CurrencyManage?

CurrencyManage is a software program for collector's of US and Canadian paper
money.  You can catalog paper money collections on your computer. This
electronic bank note collection can not only mirror the notes you currently own,
you can also track and record notes you want and notes you have sold. As you
glance through the database, you may even find a new note to add to your 'must
have' list.

Some CurrencyManage features include:
· comprehensive database
· adaptable interface
· ships with several reports and a sophisticated report designer.
· Custom Queries - Use the Query dialog to produce sophisticated queries 
· Value manager, including values for 2011

Comprehensive Database

The full version of CurrencyManage (USA/Canada) comes with a comprehensive
database of over 18,200 U.S and Canadian notes. Each note type in the
database has a representational image, helping you to match the information
accurately. When you are adding notes to a collection, you can select a note
from the database. Whenever possible, the database includes an image of the
note to simplify selection.  If you have a note that is not listed in the standard
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databases provided by CurrencyManage, you can define and add the note using
the Types and Varieties Manager.

The Types and Varieties Manager allows you to add, edit and remove notes. You
can create a new Country, denomination and type for the note. The Types and
Varieties Manager provides greater control over your collections of notes.

Adaptable Interface

The CurrencyManage interface displays the information that is important to you.
Simply click the mouse to sort any column of information. Click on the column
again to toggle between an Ascending and Descending sort.  The Preferences
area allows you to select the information you want to see on various windows. 

Types & Varieties Manager

CurrencyManage allows you to add new Types and Varieties to the master
database.  You can even associate a picture with a newly-created type if you
have a TWAIN-compatible scanner or digital camera.  Note images can also be
imported pasted from the clipboard or from images files in many different formats,
including, BMP, JPG, GIF, PNG, TIFF.

1.2 What's new in version 2016?

CurrencyManage

Values and Data

* Thousands of value changes  
* The latest banknote issues from have been added to the program.

Reporting

* CurrencyManage 2016 includes a new and improved version of the report
designer.
* Reports that are grouped will now show a Table Of Contents that make it
much easier to navigate the report.  The screenshot below shows the 
Table of Contents for a report grouped by signature.
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Collectors.Com

* One Click search for paper money on the new Collectors.com web-site. 
Collectors.com aggregates listings from eBay and many paper money dealers.
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eBay™ Searches are more accurate

* Searching eBay will return more relevant results. We have gone through
each US Note Category and made some minor changes to return better
results.

Webcam 

* Easily take pictures of your notes using a live video feed from any Webcam
on your computer.

Other New Features and improvements

* If you click in any list of Bank Notes, then type in the Friedberg number,
the banknote with that Friedberg number will become selected and scroll into
view.

* CurrencyManage shows Quantity, Total Cost, Total Value in the status bar.
 The information is specific to whatever collection, country or category you
show.

* New #Owned column will show you how many of a particular variety you
own if any.

* Many bug reports and enhancement requests have been addressed in this
version.
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1.3 Installing CurrencyManage

System Requirements

CurrencyManage 2016 requires the following minimum system requirement to
operate properly:

· Windows XP, Vista, Windows 7, 8, and 10.
· Enough RAM to run your Operating System comfortably
· 800x600 SVGA display set at High Color (16-bit) or higher
· Mouse
· At least 60 MB free hard drive space.  Note:  The Setup program will show

you exactly how much space is required, and let you know if there is not
enough space available on the selected drive.

Note: Images can greatly increase the amount of space used by
CurrencyManage.  If you attach a lot of images to records by scanning
or importing, take note of the image size.  

How Do I Install From The CD?

Simply insert the CD into your CD-ROM drive.  The setup program should start
automatically.  If the Setup program does not start automatically, run
AUTORUN.EXE from the root of the CD.  

Registration Code information

Liberty Street Software supplies a unique registration code with each
software purchase.  The code appears on the back of your manual if you
bought the CD-ROM version.   If you ever lose the code, please email us and
we will look it up for you.

Note: To Upgrade from a previous version of CurrencyManage

Run the install program for the Upgrade.  If you have purchased the Electronic
Version of the upgrade, simply run the file you downloaded.  If you have
purchase the Upgrade on CD-ROM, simply insert the CD-ROM and follow
instructions.

Your old data will automatically import if you install the upgrade to the same
subdirectory as your previous install.  This automatic import will occur the 1st
time you run CurrencyManage 2011.  You can also import data by using the
'Import CurrencyManage File...' command.
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1.4 General Operation

Menus

All important functions can be activated in the different menus.  Some of the
entries have sub-menus which automatically appear when you move the
mouse over the entries.
If a menu entry also has a button or a keyboard shortcut, this is given in the
menu

Buttons

In the menu bar at the top of the screen there are groups of buttons.

When you move the mouse onto a button, after a moment the function of the
button is displayed.
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It also appears at the bottom of the screen on the left.  Clicking a button
with the left mouse key will activate the function.

Right Mouse click

This is a very useful way to access functions.  If you right-click on any
section of the screen a context-relevant dialog box or menu appears in which
you can select functions.  

Keyboard

The most important functions can be executed from the keyboard (e.g. Ctrl+N
for New Collection).  The keyboard shortcuts are given to the right of the
entries in the menus.

1.5 Legal Notices

eBay is a Trademark of eBay Inc.

CurrencyManage 2016 is protected by Canadian and International Copyright
Laws.  Copyright© 2001-2015 by Liberty Street Software.  All rights
reserved.  No part of this document may be reproduced, transmitted or
translated into any other language by any means including but not limited to
electronic, manual, or mechanical, without the express written permission of
Liberty Street Software, 3126 Lednier Terrace, Mississauga, ON L4Y 4A1
Canada  (905) 566-5082
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Uses and Limitations

· CurrencyManage may be used on different computers, as long as there is
no possibility that the programs can be running on different computers at
the same time.

· Backup copies of CurrencyManage may be made in accordance with the
above limitation.

· You may not copy or transmit the program to any other person or group.
· You may not modify the structure of the database for the purposes of

resale or trade to a third party.

Governing Law and Judicial Jurisdiction:

This Agreement is subject to the laws of the Province of Ontario, Canada. All
disputes arising from this Agreement shall be determined under the law of
the Province of Ontario, Canada exclusively by the court having competent
pecuniary and territorial jurisdiction over the city Liberty Street has its
principal office.

Disclaimer of Warranty

THIS SOFTWARE AND THE ACCOMPANYING FILES ARE SOLD "AS IS" AND
WITHOUT WARRANTIES AS TO PERFORMANCE OF MERCHANTABILITY OR ANY
OTHER WARRANTIES WHETHER EXPRESSED OR IMPLIED.  Because of the
various hardware and software environments into which CurrencyManage may
be put, NO WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE IS
OFFERED.

LIMITATION OF LIABILITY FOR DAMAGES

IN NO EVENT SHALL LIBERTY STREET SOFTWARE OR ITS SUPPLIERS BE
LIABLE TO YOU, OR TO ANY OTHER PERSON, REGARDLESS OF THE CAUSE,
FOR ANY DIRECT, SPECIAL, INDIRECT, INCIDENTAL OR CONSEQUENTIAL
DAMAGES WHATSOEVER (INCLUDING WITHOUT LIMITATION DAMAGES FOR
LOSS OF PROFIT, BUSINESS INTERRUPTION, LOSS OF BUSINESS
INFORMATION, OR ANY OTHER PECUNIARY LOSS) ARISING OUT OF OR
RELATING TO THE USE OR INABILITY TO USE THIS SOFTWARE, EVEN IF
LIBERTY STREET SOFTTWARE HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES. IN THE EVENT THE FOREGOING LIMITATION IS FOUND BY
A COURT OF COMPETENT JURISDICTION TO BE INEFFECTIVE, THE PARTIES
AGREE THAT LIBERTY STREET SOFTWARE'S MAXIMUM LIABILITY FOR ANY
CLAIM ARISING HEREUNDER (WHETHER IN CONTRACT OR TORT INCLUDING
NEGLIGENCE, PRODUCT LIABILITY OR OTHERWISE) SHALL NOT EXCEED THE
LICENSE FEES, IF ANY, PAID BY YOU TO LIBERTY STREET SOFTWARE FOR
USE OF THE PRODUCT.

Good data processing procedure dictates that any program be thoroughly
tested with non-critical data before relying on it.

The user must assume the entire risk of using the program.  ANY LIABILITY
OF THE SELLER WILL BE LIMITED EXCLUSIVELY TO PRODUCT

REPLACEMENT OR REFUND OF PURCHASE PRICE.

ASSIGNMENT
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You may not transfer or assign the Software or license granted hereunder to
another party unless the other party agrees to all the terms and conditions
of this EULA and provided that you transfer all copies of the Software,
registration keys and/or codes, and related documentation to the same
party and destroy any copies not transferred. Any such transfer terminates
your license.

COSTS

You agree to reimburse Liberty Street Software  for all expenses incurred by
Liberty Street Software in the enforcement of any of its rights hereunder,
including without limitation, solicitors fees.

1.6 How to buy CurrencyManage

How to buy CurrencyManage 2016

CurrencyManage 2016  Order Page
http://www.libertystreet.com/currencymanage_purchasing_options.htm

CurrencyManage 2016 Web-Site
http://www.libertystreet.com/prod02.htm

1.7 Contacting Liberty Street Software

How Do I Contact You?

You can contact LibertyStreet Software at any time:

Liberty Street Software - Canadian Office
1477 Mississauga Valley Blvd.
Suite 409
Mississauga, ON
L5A 3Y4
Canada

Liberty Street Software - USA Office
228 Park Ave S #26512
New York, NY 
10003-1502
USA

· Web Site —  www.currencymanage.com

http://www.libertystreet.com/currencymanage_purchasing_options.htm
http://www.libertystreet.com/prod02.htm
http://www.currencymanage.com
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· Videos - https://www.youtube.com/channel/UCf6fOvtrNUhkpurkv_SF6Rw
· Forums - http://libertystreetsoftware.invisionzone.com/index.php?/forum/14-

currencymanage-support/
· Sales —  sales@libertystreet.com
· Technical Support — techsupport@libertystreet.com 

(347) 960-6466

Note that the About dialog box has hyperlinks to the information above.

2 Managing Notes

2.1 Creating note records

Manage your collection by recording each note you buy, sell or want.

To add a note

1.  Click Add Note(s) from the Actions menu.

2.  Define the note and indicate Condition, Cost, Value and Quantity.

Condition Field:

https://www.youtube.com/channel/UCf6fOvtrNUhkpurkv_SF6Rw
http://libertystreetsoftware.invisionzone.com/index.php?/forum/14-currencymanage-support/
http://libertystreetsoftware.invisionzone.com/index.php?/forum/14-currencymanage-support/
mailto:sales@libertystreet.com
mailto:sales@libertystreet.com
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Either select a condition from the drop-down list, or type in a condition.  

GEM UNCIRCULATED (GEM CU): A flawless uncirculated note. It is bright,
crisp, well centered, free from any traces of handling. and has no folds, creases
or bent corners.
CHOICE UNCIRCULATED (CH CU): An uncirculated note which is brighter and
more fresh than normal for its particular issue.  Must be fairly well-centered.
UNCIRCULATED (UNC): An uncirculated note with brighter than normal
coloration and crispness but not quite as fresh looking as a gem uncirculated
note. It must have no creases or bent corners.
ABOUT UNCIRCULATED (AU): A clean and bright note with its original sheen
but with some minor handling and showing very slight evidence of folds at a
corner or through the center. 
EXTREMELY FINE (XF): A crisp, good looking note with bright but very slightly
faded colors and showing light handling and some folds.
VERY FINE (VF): An attractive note, but with more evidence of handling and
wear such as several folds and some dirt and edge wear but with no tears and
minimal loss of crispness.
FINE (F): A circulated note exhibiting considerable but not serious signs of
wear such as folds, creases and wrinkling. The note will show some loss of
crispness and evidence of some discoloration. The overall appearance of the
note is still good though.
VERY GOOD (VG): A well circulated, limp note with significant wear,
discoloration, some staining, excessive folding, tiny pinholes but with no pieces
of the note missing. 
GOOD (G): The term "Good" in the grading of paper currency is almost
misleading. This grade refers to a heavily worn used note having several strong
folds and creases, discoloration, edge tears, frayed corners, surface abrasions,
stains, pinholes, and an overall poor appearance. No large pieces of the note
are missing, however.
POOR: This is the lowest grade that can be accorded to a note. Such a note is
severely damaged with large pieces missing and showing heavy surface wear,
large holes, stains and considerable discoloration.

Catalog Number:

To lookup a note by it's KL (Krause-Lemke) or FR (Friedberg) number, simply enter
the catalog number and then either press the 'Tab' key or click outside the edit
box.

3. Open the Additional Info tab. You can indicate the purchase, selling and grade
information as well as include any comments about the note.
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To automatically create a new Dealer (Bought From), Customer (Sold To),
Grading Service, Location or Set, simply enter the name instead of  picking from
the drop-down listbox.

4. If you want to create a picture of your note using a TWAIN compatible
scanner, open the Picture of my Note tab.
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5. When you finish, click Apply to add the note and keep the New Note dialog
open or click OK to add the note and close the New Note dialog.

2.2 Changing Record Info

After you create a note record, you can make changes to the information
by opening the Note Properties dialog. You can also move or copy a note
from one collection to another using the Move/Copy Note Dialog.

To edit a note

1.Select the note you want to change or view in the right window and
double-click on it or click Properties from the Note menu or toolbar. 

The Note Properties dialog appears
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2.  Make your changes and then click on the OK button to save, or the Cancel button
to discard.

2.3 Printing Records

CurrencyManage offers a comprehensive print preview feature that allows you to view
the printout before you send it to your printer. You can change the fonts and organize
the information you require to control the information that appears on each page.

: To Print (or Print Preview) a single item

To Print or Preview a single item, it is necessary to set the Detail View for the item as
the currently active view.  This can be done by either clicking in the Detail Window
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Then select Print or Print Preview from the File menu

Or simply right mouse-click in the Details View and select Print or Print Preview
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Output will look something like this:

: To Print (or Print Preview) the contents of the record list view
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Select Print from the toolbar or from the File menu.

The Print Setup dialog will appear.  From this dialog you can:
· Specify which columns you wish to print.
· You can also choose to only print the items currently selected in the list view.

2.4 Moving or Copying Notes

1. Select the note you want to move or copy and click Move/Copy Note from the
Note menu. The Move or Copy Notes dialog appears.
2. Select the collection to which you want to move or copy the note. 
3. Enable the Copy checkbox to copy the note or disable the checkbox to move
it. Click OK.
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2.5 Using the value manager

You can apply values from the value databases that CurrencyManage provides
using the Apply Values to Collections command. Each time you upgrade
CurrencyManage, you will receive new value databases as CurrencyManage release
them. To use the latest value database for your collections, use this feature.

: To apply values to collections

1. Click Apply Values to Collection(s) from
the Actions menu. The Apply Values
dialog appears. 

2. Select the value database you want to use in the Apply values from field. 
3.   Overwrite User specified values will overwrite any values that you have

entered manually into the Current Value field.  This will only be done if a value
is found for the condition specified.

4. Mark the collections you want to update. When you finish, click OK. 

2.6 Removing notes

You can remove a note from a collection when necessary.

: To delete a note

1. Select the note you want to remove and click Delete from the Note menu.
CurrencyManage prompts you to confirm the deletion.
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2. Deleted Notes are placed into the "Deleted Notes" folder.  They are not
permanently deleted until the Empty Deleted Notes command is executed.

3 Managing Collections

3.1 What are Collections?

Any collector of notes, either amateur or professional, may want to group
their notes. A collection is a group of notes. CurrencyManage provides
flexibility, allowing you to use collections in the most convenient manner for
you. 
Some collectors may want create collections for notes they want, have or
sold. Professional collectors may create separate collections for each of their
customers. The way collections work for you depends on your needs.
Some things to keep in mind when organizing your collections:

· where are the notes physically located?
· do you want to buy, sell or keep the note?
· if your collection is built on gifts, do you want to group them by giver?
· if your business is finding notes for collectors, do you want to group them

by buyer?
· Remember, if you change your collections later, you can easily move the

appropriate notes into the new collections and remove the obsolete
collections.

3.2 Creating new collections

You can create collections at any time. A collection consists of a Name,
Description and certain fields which appear on the status bar (for a quick
summary of value or income). You can change the Description and the
status bar fields as necessary. If you need to change the name of the
collection, you must remove the collection and create a new one. 
· You can create as many collections as you need.
·   You can move or copy notes from one collection to another using the

Move/Copy Notes command. For more information, see "Managing Notes",
earlier in this guide.

: To create a collection

1. Click New Collection from the File menu. The Create a New Collection
dialog appears.
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2. Provide a descriptive Name for the collection. You can optionally add
information about the collection in the Description area.

3.3 Editing Collections

You can modify the collection's description as well as the information that
appears on the status bar when the collection is opened. 

: To edit a collection

1. Select the collection you want to modify in the Collections tab in the main
window.

2. Click Properties from the Note menu. The Collection Properties dialog
appears.

3. Make changes to the Description and status bar information as
necessary.

3.4 Removing Collections

You can remove collections at any time. Remember to move your notes to
another collection before deleting the collection where they reside.
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: To remove a collection

1. Select the collection you want to delete in the Collections tab on the main
window.

2. Click Delete on the Actions menu. CurrencyManage asks you to confirm
your deletion.

3. Click Yes to remove the collection.

4 How Do I

4.1 Add Bank Note data to the program database?

CurrencyManage 2011 comes with data for over 18,200 notes from the USA
and Canada.  If you would like to add bank note data not in the pre-defined
database, you can use the Types & Varieties Manager feature.

: To add new note information using the Types & Varieties Manager

To add new bank note information using the Types & Varieties Manager:

1. Click Types and Varieties Manager from the File menu.  The Types &
Varieties Manager dialog appears. 

2. To add notes from a new country, type the name of the country into
the 'Country' field.  To add notes to an existing country, select the country
from the pull-down.  

3. To add notes for a new denomination, type the name of the
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denomination into the 'Denomination' field.  To add notes to an existing
denomination, select the denomination from the pull-down.

4. Enter the 'Type Name' and 'Years of Issue' (if applicable) into the
appropriate fields.

5. The 'Denomination Weight' and 'Type Order' fields are used internally for
sorting purposes. Lesser denominations should have lower numbers so that
they will appear before higher denominations.  A denomination with a
'Denomination weight' of 1000 (one dollar) will appear before a denomination
with a weight of 10000 (ten dollars).  The 'Type Order' field works in a similar
fashion.  Types that were issued earlier chronologically should have lower
numbers.  So "One Dollar/Treasury or Coin Notes/1890-91" should have a
lower 'Type Order' value than "One Dollar/Federal Reserve Bank Notes/Series
1918".

6. Once a new type has been entered, you can start entering varieties for
that type.  You can do this by clicking on the 'Notes' tab.

7. Double-click within the one of the columns and begin entering
appropriate information for all the notes that belong to your new type.  Use
the Tab key to move to the next column and the Enter key to save the
current record and move to the next record.
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The Scanner/Digital Camera buttons are used for scanning in images to be
used for the currently selected variety.  The Select Source... button is used
to select which TWAIN-compatible scanner or digital camera will be used
when the Acquire Image... button is selected.  Clicking the Acquire Image
button will bring up the dialog associated with your scanner or digital camera.
  

4.2 Change column settings?

& CurrencyManage stores custom column information for each Type in the

program database. This is why you will see different columns when displaying
notes from different Types.  

How Do I Change Column Settings for a particular Type?

1. Select the Type whose columns you want to change.  Then select
Properties... by using right mouse click or from the main menu or toolbar.
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2. Click the Type Fields tab and change the columns as you wish.

How Do I Change Global Column Settings ?

Each collector has different needs and requires different information from
CurrencyManage. Liberty Street has kept these differences in mind when
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designing CurrencyManage. You can determine the information you need most
often or is most important to you. 

:  To specify the information you want to view

 From the CurrencyManage Preferences (Tools > Preferences...) dialog, open
the Columns tab.

For each category, select and organize the columns you want to see using
the following buttons:

Delete—select a column in the Show the Following area and click Delete
to remove the column from the display.

Add—select a column in the Available Columns area and click Add to
display the column.

Move Up—select a column in the Show the Following area and click
Move Up to have the column display further to the left.

Move Down—select a column in the Show the Following area and click
Move Down to have the column display further to the right.

Reset—click Reset to ignore your changes and return to the default
column setup.
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4.3 Change information for more than one record at a time?

You may occasionally wish to go back and change some information common
to more than one note record in your collection.  For example, you may wish to
add 3 notes to your Want list.  Rather than edit each record individually and
check the Want checkbox,  there is a much easier way to do this.

: To change information for multiple records

1.  Select all the bank note records whose data you wish to change.  Then
select Properties from the main menu or from the right mouse-click context
menu.

2.  Specify the information that will be updated for all the selected records. 
Note that leaving a field blank will not result in the information for that field be
set to empty.   The field will retain the data (if any) if contained previously. 
The example below will result in the 2 selected records being marked as sold on
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Oct. 28, 2010.

4.4 Change the Data File Location?

The location of the CurrencyManage data file can be changed from within the 
Preferences... dialog (under the Tools menu).  Note that it is necessary that
 there must be a PAPERDB.MDB data file in the new folder, you must then
restart the program after changing the location of the program data file.
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4.5 Create A Query?

Suppose you would like to view all the bank notes that you acquired in
December of 2000, or perhaps you would like to view all the bank notes you
own that are worth more than 1000 dollars.  You can accomplish this by
creating a CurrencyManage Query.  To create a Query either:

· Select Add Query from the Actions menu or
· Type Ctrl+Q from the keyboard

A valid query requires a name, and at least 1 condition.  The Create and
Create and Execute buttons will only be enabled when a valid query has
been specified.  Below is an example of a query.   When executed, this query
will display all paper money from the collections selected purchased in
December of 2000.
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Once a query has been successfully added, it can be viewed in the Queries
section as seen below

To execute the Query, simply click on it.  

4.6 How is the value of a note determined?

You can allow CurrencyManage to automatically determine the value of a note
or you can manually enter the value. If you want CurrencyManage to
automatically determine the note's value, specify the value database to use.

1. From the CurrencyManage Setup dialog (Tools/Preferences...), choose one
of the following options in the Values area:

· enter values manually when adding a note (you determine the value)
· automatically insert values from: (CurrencyManage selects the value using

the value database you specify)
2. If you selected CurrencyManage to automatically enter the values from a

value database, specify the value database to use.
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4.7 Retrieve National Bank Note information?

CurrencyManage 2011 contains a table of information on virtually all 14,000+
US National Bank Notes.  To enter a National Bank Note:

Click on the "Additional Info" tab within the "Add Note" dialog

Enter the Charter Number of the Bank Note and then click the "Lookup Info"
button

The City, State and Bank information will be automatically entered in the
appropriate fields.  

4.8 Show values in the currency of my country?

You can select a Currency Conversion Rate for the value database to ensure
that the pricing is accurately reflected for your country. CurrencyManage
uses the US dollar as the base. If, for example, you reside in Canada, you
would enter the amount of money that would equal one US dollar, such as 1.2
 

To enter the Currency Conversion Rate, choose the File/Preferences... menu
item.

4.9 Sort Records?

How Do I Sort Records?

Sorting is simple.  Simply click on the column header to sort on a particular
column.  Click on the header again to toggle the sort from Ascending to
Descending and vice-versa.
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5 Troubleshooting

5.1 Frequently asked questions

Q: What do "FR#" and "KL#" stand for?

A:  "FR#" stands for Friedberg number.  This is a popular numbering system
for identifying banknotes.  "KL#" stands for Krause-Lemke number, which is
another numbering system.

Q: Many notes have an asterisk '*' at the end of the FR# or KL#, what does
this stand for?

A:  Notes with an asterisk '*" are known as "Star Notes", which are notes
with a star symbol at the end of the serial number.

Q:  CurrencyManage crashes when exiting, or when adding items.

A:  This is usually because the Headers.wcd has become corrupted.  Delete
the file and try running CurrencyManage again.

Q:  When trying to run CurrencManage, a message similar to this appears:
"The Microsoft Jet database engine cannot open the file ...

\CurrencyManage\PAPERDB.mdb. It is already opened exclusively by 
another  user, or you need permission to view its data."

A:  This usually happens when a file called PAPERDB.ldb gets corrupted. 
Delete PAPERDB.ldb (NOT PAPERDB.mdb !!) from your CurrencyManage
directory and try running the program again.

Q:  How often is CurrencyManage updated?

A:  CurrencyManage is updated once every 18 months or so.  Updates will
cost around $20 for Electronic Delivery and $26+Postage for the update
delivered on CD-ROM with a printed manual.  Yearly updates include
improvements to the program,  additional database information, and updated
values.   We will email all customers whenever a new yearly update is
available.
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